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Contiene las siguientes lecciones: 
 
 

• Lección 1: Crear/Reanudar formularios W-2 por Internet 

• Lección 2: Descargar Informes ya Presentados 

• Apéndice: Otras páginas 
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LECCIÓN 1: CREAR/REANUDAR FORMULARIOS «W-2 ONLINE» 
Siga las siguientes instrucciones para crear hasta cincuenta informes con cincuenta formularios «W-2 
Online» en cada informe.  

PASO 1: Dirija su navegador a la página del «Business Services Online (BSO, siglas en inglés) titulada 
«Welcome to Business Services Online» (Bienvenido a los Servicios por Internet para 
Empresas): www.segurosocial.gov/bso/bsowelcome.htm (solo disponible en inglés). 

 

 

PASO 2: Seleccione el botón de «Log In» (Ingrese) en la página titulada «Business Services Online 
Welcome». El sistema mostrará la página titulada «Log In to Online Services» (Ingrese a los 
Servicios Electrónicos).  

http://www.segurosocial.gov/bso/bsowelcome.htm
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PASO 3: Ingrese su «User ID» (Identificación de Usuario) y «Password» (Contraseña). 

PASO 4: Seleccione el encasillado que dice «I have read & agree to these terms» (He leído y estoy de 
acuerdo con estas condiciones) en la página titulada «Log In to Online Services». 

Seleccione el botón de «Log In» para ver la página titulada «BSO Main Menu » (menú inicial 
del BSO).  

Para regresar a la página inicial del BSO titulada «Welcome to Business Services Online» 
(Bienvenido a los Servicios por Internet para Empresas), seleccione el enlace que dice «BSO 
Welcome» (Bienvenido al BSO) que está en la parte superior o inferior de la página. 

  

 



Guía del BSO – Año Tributable 2012                                                                      W-2 por Internet  
  
 

   
Administración del Seguro Social  Página 3 

 
PASO 5: Seleccione el enlace que dice, «Report Wages to Social Security» (Informe los Salarios al 

Seguro Social) en la página titulada «BSO Main Menu». El sistema mostrará la página titulada 
«Wage Reporting Attestation» (Confirmación de la Presentación de Salarios). 

 

PASO 6: Seleccione el botón que dice «I Accept» (Acepto) en la página titulada «Wage Reporting 
Attestion» para ir a la página inicial del «EWR» (EWR home). 

 Para regresar a la página del «BSO Main Menu», seleccione el botón que dice «I DO NOT 
Accept» (No Acepto). 
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PASO 7: En la página inicial del «EWR»: 

 La ficha de los formularios «Forms W-2/W-3 Online» (Formularios W-2/W-3 por Internet) es 
la pantalla predeterminada. 

Seleccione el enlace que dice, «Create/Resume Forms W-2/W-3 Online» (Crear/Reanudar 
los formularios W-2/W-3 por Internet).  Si no se encuentran informes que no hayan sido 
presentados, el sistema mostrará la página que dice «Before You Create Your Form(s)  
W-2/W-3» (Antes que comience a llenar sus formularios W-2/W-3). Si existen formularios  
W-2/W-3 que no han sido presentados, el sistema mostrará la página titulada «Forms W-2/W-3 
Online Unsubmitted Reports».   

Puede tener un máximo de cincuenta registros de salarios que no haya presentado. Cuando 
haya alcanzado el límite de cincuenta registros «guardados», se le requerirá que primero 
presente por lo menos uno de los registros guardados antes de que se le permita comenzar un 
registro nuevo. Si tiene cuarenta y nueve registros, o menos, puede continuar sin presentar los 
registros que ya existen. 
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PASO 8:  En la página titulada «Unsubmitted Reports»: 

                Seleccione el botón de «Start a New Report» (Comience un informe nuevo). El sistema 
mostrará la página titulada, «Before You Create Your Form(s) W-2/W-3» (Antes que comience 
a llenar los formularios W-2/W-3).  

Seleccione el enlace que dice, «Edit» (Editar) o el enlace que dice «Employer Name» (Nombre 
del empleador) para ir a la página titulada «W-2 List for this Submission» (Lista de los 
formularios W-2 correspondientes a este informe). 

Seleccione el enlace que dice Delete (Borrar) para borrar un informe que no ha sido presentado. 
El sistema mostrará la página que dice «Are you sure you want to delete the unsubmitted 
report?» (¿Está seguro que quiere borrar el informe que no ha sido presentado?).  

Seleccione el botón de «Cancel» (Cancelar), para regresar a la página principal del «EWR» 
(EWR home). 
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PASO 9: En la página titulada «Before You Create Your Form(s) W-2/W-3» (Antes que Comience  
  a Llenar su(s) Formulario(s) W-2/W-3): 
 

Provea la información correcta correspondiente al Año Tributable, el nombre de su 
empresa, el número de EIN y el tipo de formulario W-2 que quiere crear. Si ha recibido 
una carta de reconciliación, seleccione el encasillado que dice «YES» a la derecha de la 
pregunta que dice «Have you received a Reconciliation Letter?».  
 
Si ninguna de las situaciones nombradas en la sección que dice «Check for Exception» 
(Verifique si existe alguna excepción) aplica, seleccione el botón de «Continue» para ir a 
la página titulada, «Employer Information for this Wage Report» (Información 
Empresarial para este Informe de Salarios).  
 
Si se aplica alguna de las situaciones descritas en la sección de «Check for Exception», 
seleccione el encasillado apropiado y el botón de «Continue» para ir a la página titulada 
«W-2 Online Restrictions» (Restricciones al Programa de W-2 por Internet).  
 
Seleccione el botón de «Cancel» (Cancelar), para regresar a la página principal del 
«EWR» (EWR home). 
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PASO 10: En la página titulada «Employer Information for this Wage Report»: 

Ingrese o revise la información de su empleador, información de la persona de contacto, 
cualquier otra información y seleccione la categoría del pagador (Kind of Payer) y la categoría 
de empleador (Kind of Employer), luego seleccione el botón de «Continue» para ir a la página 
titulada, «Enter W-2 Information» (Ingrese la información para el formulario W-2).  

Si existe algún informe del año anterior, el sistema lo presentará en pantalla. 

 
 

El usuario puede elegir el usar estos informes para los propósitos de pre-llenar algunos encasillados al 
seleccionar uno de los «WFID» para ir a la página titulada «W-2(s) Available for WFID XXXXXX» 
(formularios W-2 disponibles para identificadores de informes de salarios [WFID, siglas en inglés] 
número XXXXXXX) o elija el crear nuevos formularios W-2 seleccionando el botón de «Continue» para 
ir a la página titulada «Enter W-2 Information» (ingrese la información del formulario W-2).    

Seleccione el botón de «Cancel» (Cancelar), para regresar a la página principal del «EWR» (EWR home). 
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PASO 11: En la página titulada «W-2(s) Available for WFID XXXXXX: 

Seleccione el formulario W-2 que usted quiera usar para pre-llenar los encasillados de los 
formularios W-2 de este año. Luego seleccione el botón de «Continue» para ir a la página 
titulada «W-2 List for this submission» (Lista de los formularios W-2 para este informe). 

Luego seleccione el botón de «Previous» (Anterior) para regresar a la página titulada, 
«Employer Information for this Wage Report» (Información de la empresa que presenta este 
informe de salarios). 

Seleccione el botón de «Cancel» (Cancelar) para regresar a la página principal del «EWR» 
(EWR home). 

 
PASO 12:  En la página titulada, «W-2 List for this Submission page» (Lista de los Formularios W-2 para 

esta Presentación): 

Si aparece este símbolo en la columna titulada «Status», esto indica que el formulario ha 

sido pre-llenado con parte de la información, pero todavía le falta información. Para terminar 
de llenar el formulario, por favor elija un nombre y continúe a la página titulada «Enter W-2 
Information» (Ingrese la Información del Formulario W-2). 

Cuando haya completado todos los formularios que han sido pre-llenados, el símbolo  será 

remplazado con esta marca de cotejo . 
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Seleccione un nombre para ver y corregir la información del formulario W-2.  

Seleccione el enlace que dice «Delete» para borrar el formulario W-2. Cuando seleccione este enlace para 
borrar el formulario, la página titulada «Are you sure you want to delete this W-2» (Está seguro que 
quiere borrar este W-2) aparecerá para ayudarle. 

Seleccione el botón que dice «Save and Quit» (Salir y guardar) para salir del formulario W-2 por Internet  
sin presentar su informe de registros de salarios al Seguro Social. Cuando seleccione este botón (Salir y 
guardar), la página titulada «Are you sure you want to save and exit W-2 Online without submitting your 
annual wage report to SSA?» aparecerá para ayudarlo. 

Seleccione el botón de «Edit Employer Information» (Editar la información del empleador) para a la 
página de «Employer Information for this Wage Report» (Información de empleador para este informe de 
salarios).  

Seleccione el botón de «Start a New W-2» para ir a la página titulada «Enter W-2 Information» (Ingresar 
la Información del formulario W-2).  

Seleccione el botón de «Continue to W-3 Preview» (Continuar a la vista preliminar del formulario W-3) 
para ver la página titulada «W-3 Preview for this Submission» (Vista preliminar de los formularios W-3 
para esta presentación). Si uno de los formularios que usted ha pre-llenado no ha sido completado, el 
botón de «Continue to W-3 Preview» no estará activo. 
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PASO 13:  En la página titulada ««Enter W-2 Information»: 

Seleccione el botón de «Save and Create a New W-2» (Guardar y crear un nuevo formulario 
W-2) para guardar la información de este formulario W-2 y crear un nuevo formulario W-2. Es 
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posible que el sistema presente algunos sobre avisos. Si esto sucede, puede proceder ya sea 
haciendo las correcciones al formulario W-2 o seleccionando el encasillado que invalida el 
sobre aviso. 

Seleccione el botón de «Save and Go to Next W-2» (Guardar el formulario y proseguir al 
próximo formulario W-2) para guardar la información del formulario W-2 y editar el próximo 
formulario W-2 que aparece en la lista de los formularios W-2 para esta presentación (W-2 List 
for this Submission ). Es posible que el sistema despliegue algunos avisos en pantalla. Si esto 
sucede, puede proceder ya sea haciendo las correcciones al formulario W-2 o seleccionando el 
encasillado que invalida el sobre aviso. 

Cuando termine de llenar o editar los formularios W-2, seleccione el botón de «Save and Go to 
W-2 List» (Guardar los formularios y proseguir a la lista de los formularios W-2), para 
continuar a la página titulada «W-2 List for this Submission» (Lista de los formularios W-2 
para esta presentación). 

 Puede ingresar hasta un máximo de cincuenta formularios W-2. El número del W-2 actual se 
muestra en la parte superior de la página titulada «Enter W-2 Information». Cuando haya 
ingresado el formulario número cincuenta, el sistema ya no mostrará el botón de «Save and 
Start Next W-2». 

 Seleccione el botón de «Cancel Changes» (Cancelar los cambios) para rechazar los cambios 
efectuados a este W-2 y proseguir a la página titulada «W-2 List for this Submission». 

                  Seleccione el botón de «Delete this W-2» (Borrar este W-2): Si el formulario ha sido 
guardado previamente, el sistema mostará la página titulada «Are you sure you want to delete 
this W-2» (¿Está seguro que quiere borrar este W-2?); si el formulario no ha sido guardado 
previamente, el sistema mostrará la página titulada «W-2 List for this Submission». 
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PASO 14:  En la página titulada, «W-3 Preview for this Submission» (Vista preliminar de los 

formularios W-3 para este informe): 
 
Las sumas que aparecen en los encasillados 16, 17, 18 y 19 son totales directamente de las 
cantidades de los impuestos estatales que ingresó en los formularios W-2. Si su intención es 
usar este formulario para informar las cantidades a su estado y su estado tiene diferentes 
reglas para reportar estas cifras, puede ingresar sus propias sumas y seleccionar el encasillado 
que dice I Agree (Estoy de acuerdo) para continuar. El Seguro Social no utilizará esta 
información ni tampoco la compartirá con ningún estado o entidad local. 

 
Seleccione el botón de «Continue» para ir a la página titulada, «Print Unsubmitted Form(s) 
W-2/W-3 for Review» (Imprima los formularios W-2/W-3 que no se han presentado). 

 

Seleccione el botón de «Return to W-2 List» para regresar a la página titulada «W-2 
List for this Submission». 

Seleccione el botón de «Save and Quit» para salir del W-2 electrónico sin presentar 
el registro de su salario al Seguro Social. Cuando seleccione este botón, la página 
titulada «Are you sure you want to save and exit W-2 Online without submitting your annual 
wage report to SSA» aparecerá para ayudarlo. 
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PASO 15:  En la página titulada, «Print Unsubmitted Form(s) W-2/ W-3 for Review»: 

Seleccione el botón de «Continue» para continuar a la página titulada «Sign and Submit» 
(Firmar y Presentar).   

Seleccione el botón de «Return to W-2 List» (Regresar a la lista de formularios W-2) para 
regresar a la página titulada «W-2 List for this Submission». 

Seleccione el botón de «Save and Quit» para salir del W-2 sin presentar la información al 
Seguro Social. Cuando seleccione este botón, la página titulada «Are you sure you want to 
save and exit W-2 Online without submitting your annual wage report to SSA» aparecerá 
para ayudarlo. 
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PASO 16: En la página titulada «Sign and Submit»: 

Seleccione la casilla de verificación para verificar la exactitud del informe y seleccione el 
botón de «Submit This Wage Report Correction» (Presentar la corrección de este informe  
de salarios) y así presentará su informe de corrección de salarios. El sistema mostrará una 
página con una ventanilla despegable diciendo «Confirmation Receipt - Your File Was 
Received» (Recibo de Confirmación - Su registro ha sido recibido). 

Seleccione el botón de «Save and Quit» (Guardar y Salir) para salir sin presentar la 
corrección de su informe de salario al Seguro Social. Cuando seleccione este botón, aparecerá 
la página de «Are you sure you want to save and exit W-2 Online without submitting your 
annual wage report to SSA» para ayudarlo. 

Seleccione el botón de «Previous» para regresar a la página titulada «Print Unsubmitted 
Form(s) W-2 for Review» (Imprimir los formularios W-2 que no han sido presentados para  
revisarlos).  
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PASO 17: En la ventanilla despegable: 
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Seleccione el botón de «OK» para imprimir la página de «Confirmation Receipt – Your file 
was received». 

Seleccione el botón de «Cancel» para cerrar la ventanilla desplegable.  

PASO 18:  En la página de «Confirmation Receipt – Your File Was Received»: 

 Seleccione el botón de «Print this Page» para imprimir la página de la confirmación.  

 Seleccione el botón de «Go to Save Official PDF» (Proseguir al registro PDF oficial y 
guardarlo) para ir a la página titulada, «Save PDF» (Guardar el registro PDF). 

El registro de su salario estará disponible para que lo revise bajo su cuenta de BSO hasta la 
fecha indicada en la página de su «Save PDF». 

 

PASO 19: En la página titulada «Save PDF»: 

Oprima el botón derecho del ratón en el nombre del registro (<filename.pdf>) para ver o 
guardar el informe presentado.  
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Seleccione el botón de «Start a New Wage Report» (Comenzar un nuevo informe de 
salarios) para regresar a la página titulada, «Before You Create Your Form(s) W-2/W-3» 
(Antes que comience a crear sus formularios W-2/ W-3). 

Seleccione el botón de «View Unsubmitted Reports» (Ver los Informes que no se han 
presentado) para ir a la página titulada, «Unsubmitted Reports» (Informes que todavía no se 
han presentado). 

Para regresar a la página principal del «EWR», seleccione el botón de EWR home.
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LECCIÓN 2: DESCARGANDO LOS REGISTROS PRESENTADOS 
Siga las siguientes instrucciones para descargar un expediente en formato de Adobe que contiene los 
formularios W-2 y W-3 referente a un informe del formulario W-2 presentado por Internet durante los 
últimos 30 días.      

Informes de registros de salarios ya presentados están disponibles por 30 días o hasta el 31 de diciembre, 
lo que ocurra primero.  

PASO 1: Seleccione el enlace que dice «Save (or Print) Submitted W-2 Report(s)/PDF to Your 
Computer» (Guardar [o imprimir] informes ya presentados de los registros de los formularios 
W-2/registro PDF en su computadora) que está bajo la ficha de los formularios W-2/ W-3 
Online en la página inicial del EWR. El sistema mostrará la página titulada «Download 
Submitted Reports» (Descargar los informes que ha presentado).   

 

PASO 2:  Haga un clic derecho en el enlace WFID en la página titulada «Download Submitted Reports» 
para ver un menú que incluye las siguientes opciones:   

• Seleccione el botón de «Save Target As» (Guardar el registro como) para descargar el 
expediente a su computadora.  

• Seleccione el botón de «Open in New Window» (Abrirlo en una ventanilla nueva) para 
ver el registro. 

Nota aclaratoria: Se requiere el programa de computadora «Adobe Reader» para ver el expediente de 
salarios que descargó. Si no tiene una copia de este programa de computadora, puede obtener una copia 
en www.adobe.com.   

Nota aclaratoria: Si se ha borrado una presentación a través del «Submission Status» por el usuario, se 
desplegará un mensaje para informar al usuario que el informe no es descargable. 

Para regresar a la página principal del «EWR home», seleccione el botón que dice «Quit» (Salir).  



Guía del BSO – Año Tributable 2012                                                                      W-2 por Internet  
  
 

   
Administración del Seguro Social  Página 20 

Seleccione el botón de «Start a New Report» para proceder a la página de «Before You Create 
Your Form(s) W-2/W-3» (Antes de Crear su formulario(s) W-2/W-3).  

Apéndice: Otras páginas 
1. ¿Está Seguro que Quiere Borrar esta Página del W-2? 

Si un usuario selecciona el botón de «Delete This W-2» (Borre este W-2) en la página titulada «Enter W-
2 Information» (Ingrese la información del W-2), el sistema mostrará la página con la pregunta «Are you 
sure you want to delete this W-2?» (¿Está seguro que quiere borrar este W-2?).    

 

2. ¿Está Seguro que Quiere Guardar y Salir de la Página del W-2 por 
Internet Sin Presentar su Informe Anual de Registros de Salarios al 
Seguro Social?  

Si un usuario selecciona el botón de «Save and Quit» en la página titulada «W-2 List for this Submission 
(ABC Limited)» (Lista de los formularios para este informe [ABC Limitado]), en la página titulada «W-3 
Preview for this Submission» (Vista preliminar de este informe de los formularios W-3), la página 
titulada «Print Unsubmitted Form(s) W-2/W-3 for Review» (Imprimir los formularios W-2/W-3 que no 
ha presentado para revisarlos) o en la página titulada, «Sign and Submit» (Firmar y presentar el informe), 
el sistema mostrará la página titulada con la pregunta, «Are you sure you want to save and exit W-2 
Online without submitting your annual wage report to SSA?» (¿Está seguro que quiere guardar el informe 
y salir del W-2 por Internet sin presentar su informe anual de registros de salarios al Seguro Social?). 
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3. ¿Está Seguro que Quiere Borrar la Página que dice «Unsubmitted 
Report»? (Informe que no ha sido presentado)  

 
Si un usuario selecciona el botón de «Delete» (Borrar) en la página titulada «Unsubmitted Reports», el 
sistema mostrará la página con la pregunta «Are you sure you want to delete the unsubmitted report?» 
(¿Está seguro que quiere borrar este informe que no ha presentado?). 

 

4. Página de restricciones del W-2 por Internet  

Los usuarios pueden tener acceso a la página de «W-2 Online Restrictions» (Restricciones del formulario 
W-2 disponible por Internet) seleccionando el botón de «Continue» en la página titulada, «Before Your 
Create Your Form(s) W-2/W-3» (Antes de llenar sus formularios W-2/W-3 por Internet), si selecciona el 
encasillado que dice «Yes, one or more of these situations apply to this wage report» (Sí: Una o más de 



Guía del BSO – Año Tributable 2012                                                                      W-2 por Internet  
  
 

   
Administración del Seguro Social  Página 22 

estas situaciones aplican a este informe de salario). 
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